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I. SCOPE 
 
This manual is provided for the operator of the analyzer.  Technical data, Section II, and 
principles of operation, Section III, are provided to acquaint the operator with the unit. 
 
In addition to operating instructions, Section IV, calibration instructions are included, as the 
operator can perform field calibration. 
 

II. TECHNICAL DATA 
 
1. Ranges 
 

CO2 0 - 100% 
HFC-227EA 0 - 20% 
 

2. Principle of Operation 
 

Thermal conductivity 
 

3. Basic Components 
 
 Quantity Part Number Description 
 
 1  Analyzer 
 1  Power Cord (120vac units only) 
 3  Sample Line (50ft. [15.24m] long, ¼” O.D. x 1/8” 

I.D.) 
 

4. Sampling System Characteristics 
 
Sample line internal volume 0.48 liters 
Sample flow rate into the unit 1.5 liters/minute 
Response time (0-95% or 95-0%) 60 seconds 

 
5. Dimensions 

 
7.5”H x 21”L x 17”D 
 

6. Weight 
 
Analyzer 30 lbs. [13.6kg] 
Analyzer with all components 35 lbs. [15.9kg] 
 

 
7. Electrical Requirements 
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Source 120Vac (220Vac optional) 



8. Accuracy 
 
±2% of full scale between 90% and 105% of line voltage 
 

9. Linearity 
 
±2% of full scale 
 

10. Zero Drift 
 
Maximum +1.5% of full scale/30 minutes 
Typical +2.0% of full scale/2 hours 
 

11. Readability 
 
±1% of full scale 
 

12. Operating Temperature Range 
 
32 ° – 104 ° F (0 ° – 40 ° C) 
 
Maximum calibration deviation of ±2% of full scale with a ±10 ° F (±6 ° C) variation in 
temperature 
 

13. Operating Humidity Range 
 
0 – 95% non condensing 
 
Maximum deviation of ±2% of full scale or less with a change in relative humidity of 20 – 
95% 
 

III. Principles Of Operation 
 

1. Thermal Conductivity Measurements 
 
The analyzer uses the thermal conductivity properties of the selected gas to measure its’ 
concentration in air.  There are three independent channels in the analyzer.  Each 
channel uses two glow-wire sensors that function electrically as heated resistors 
connected to a bridge circuit. 
 
One glow-wire is mounted inside a “blind cell” (air filled) for reference.  When this 
reference sensor reaches thermal equilibrium, it acts as a fixed resistance in the bridge 
circuit.  The second glow wire is mounted inside the “sample cell”.  At alignment, the 
sample cell is filled with air and its’ sensor is balanced against the reference sensor. 
 
During sampling, the air/sample gas mixture that is a better insulator than air only, is 
introduced into the sample cell.  Therefore, as gas concentration increases, the glow-wire 
becomes increasingly insulated from the cell wall and its’ temperature increases.  With 
increased temperature, the resistance of the glow-wire increases, thus unbalancing the 
bridge with respect to the constant resistance of the reference sensor. 
 
The bridge circuit output is amplified and converted to an analog signal.  Circuit operation 
is the same for all sample gases except that different span (gain) components are 
selected for each gas.  Recording is not continuous, but occurs at the end of the timing 
cycle as described in the next paragraph. 
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2. Timing Cycle 
 
Air or gas flowing through the sample cell cools the glow-wire mounted in the sample cell.  
This cooling effect opposes the heating effect of the sample gas in the mixture. 
 
A 4 second timing cycle is used in the analyzer to eliminate the cooling effect of sample 
flow.  Through electronic circuitry, a solenoid valve is opened.  This allows a sample to be 
pumped into the sample cell.  After 2 seconds the solenoid valve closes.  With flow 
interrupted, the cell reaches a thermal equilibrium that is a function of gas concentration.  
At the end of 2 seconds the gas concentration is displayed on the LCD, logged for later 
downloading and converted to a 0-50mVdc signal.  This completes the 4 second cycle. 
 

IV. OPERATING INSTRUCTIONS 
 
NOTE: 
 

Refer to Figure 1 for illustration of controls and indicators. 
 
1. Connect all sample lines to sample input fittings on analyzer front panel.  All sample lines 

must be connected and free of obstructions or constrictions for proper operation of the 
unit. 
 

2. Connect power cord between unit and power source, 120Vac (220Vac optional). 
 

3. Set GAS SELECTOR switch for gas reading desired. 
 

4. Set AQUIRE/DOWNLOAD switch to Acquire. 
 

5. Energize unit by setting power switch to ON position 
 

6. Place end of sample lines at desired locations. 
 

7. Allow unit to stabilize with all lines pulling room air.  Adjust ZERO knobs as necessary to 
obtain 0% output signal. 
 

8. Sampling may now begin. (Make allowance for response time when interpreting output 
signal.) 
 

9. After sampling is complete, turn off power and set the ACQUIRE/DOWNLOAD switch to 
the Download position. 
 

Caution 
 
If the unit is re-powered with the ACQUIRE/DOWNLOAD switch in the Acquire 
position, the data stored in memory will be overwritten! 
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Figure 1 
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Panel Layout 



II. HFC-227ea CALIBRATION 
 

NOTE: 
 
Refer to Figure 2 for set-up diagram. 
 
Calibration gas required is 5% HFC-227ea. 
 
1. Set GAS SELECTOR switch to HFC-227ea. 

 
2. Connect 12” [30.5cm] calibration jumper between channels 1 and 3 sample input 

fittings. 
 

3. Set power switch to on. 
 

4. Adjust ZERO knob on each channel to 00.0% output signal.  A reading of –0.0% 
indicates a negative value.  Turn knob clockwise to increase reading. 
 

5. Connect 3ft. [0.91m] calibration line between calibration gas cylinder regulator and 
channel 2 sample input fitting. 

 
6. Adjust pressure regulator of calibration gas cylinder to ensure positive flow out of the 

open end of the tee.  Caution:  Do not over pressurize the unit, damage could occur. 
 

7. Adjust span control for each channel to calibration gas mixture concentration.  Turn 
knob clockwise to increase reading and counterclockwise to decrease reading.  A 
reading of INV% indicates a value above 20%. 
 

8. Shut off calibration gas. 
 

9. Disconnect 3ft. [0.91m] calibration line from fitting. 
 

10. Touch-up ZERO knob on each channel (after trace levels off at baseline). 
 

11. Reconnect 3ft. [0.91m] calibration line between calibration gas cylinder regulator and 
channel 2 sample input fitting. 
 

12. Repeat steps 8 through 11. 
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13. Disconnect all lines. 
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Figure 2 
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HFC-227ea Calibration Diagram 



III. CO2 CALIBRATION 
 

NOTE: 
 
Refer to Figure 3 for set-up diagram. 
 
Calibration gas required is 100% CO2. 
 

1. Set GAS SELECTOR switch to CO2. 
 

2. Connect 12” [30.5cm] calibration jumper between channels 1 and 3 sample input fittings. 
 

3. Set power switch to on. 
 

4. Adjust ZERO knob on each channel to 000% output signal.  A reading of –00% indicates 
a negative value.  Turn knob clockwise to increase reading. 
 

5. Connect 50ft. [15.25m] calibration line between calibration gas cylinder regulator and 
channel 2 sample input fitting. 
 

6. Adjust pressure regulator of calibration gas cylinder to ensure positive flow out of the 
open end of the tee.  Caution:  Do not over pressurize the unit, damage could occur. 
 

7. Adjust span control for each channel to calibration gas mixture concentration.  Turn knob 
clockwise to increase reading and counterclockwise to decrease reading.  A reading of 
INV% indicates a value above 100%. 
 

8. Shut off calibration gas. 
 

9. Disconnect 50ft. [15.25m] calibration line from sample input fitting. 
 

10. Touch-up ZERO knob on each channel (after trace levels off at baseline). 
 

11. Reconnect 50ft. [15.25m] calibration line between calibration gas cylinder regulator and 
channel 2 sample input fitting. 
 

12. Repeat steps 8 through 11. 
 

13. Disconnect all lines. 
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CO2 Calibration Diagram 



VII. CALIBRATION CERTIFICATION 
 
Failing a discharge test is very expensive and easily preventable, if it was only due to an 
analyzer being out of calibration.  In order for you to assure the accurate calibration of your 
analyzer at the test site, Tripoint Instruments would like to clarify exactly how a unit is factory 
calibrated. 
 
When an analyzer is returned for repair and/or factory calibration, it is semi-disassembled, all 
orifices cleaned, internal filters replaced (if necessary), the vacuum pump cleaned and 
pressure checked, and all manifold connections tightened. 
 
We allow the unit to warm up approximately 30 minutes and introduce certified diluted gas 
mixtures into the unit.  All three span controls (pots) are adjusted to make the three output 
signals each read as required.  Then and only then, we prepare calibration reference values 
by introducing 100% gas. 
 
In repeating the 100% gas field calibration check at the site, if the readings found do not 
exceed 2% of the values from the previous calibration, you know that your system is 
functioning properly and that the dilution by the vacuum system of the 100% gas has not 
changed.  More importantly, the unit should have the same calibration as when it left the 
factory. 
 
When the unit has been used on numerous tests, it is not unusual for dirt to get into the 
vacuum pump or in the lines and even into the orifices.  Clogged filters, differences in line 
voltage (which is very common), temperature changes or changes in barometric pressure can 
also cause the unit, even if it is in perfect calibration, to give higher readings.  This is due to 
the fact that the vacuum system is drawing in less air and thus not diluting the 100% gas to 
the same degree as when checked out at the factory. 
 
If each time one gets a higher reading the span pots are turned down, the unit will be slowly 
brought out of calibration and will now be reading lower values than actual test results. 
 
However, if you use a source of certified gas mixture just before each test at the site, you can 
verify and check the calibration.  If necessary, you can adjust the unit to make all the output 
signals read the same value as the calibration gas.  This will eliminate all errors.  Your unit 
will now be in perfect calibration and there can be no doubt as to the results obtained on any 
test. 
 
Tripoint Instruments highly recommends that you check the calibration of the analyzer before 
every test using an exact known concentration of gas.  We believe that this is a very good 
practice and should only take about 15 minutes of your time.  It does seem very foolish to risk 
the chance of failing an expensive discharge test due to the unit being out of calibration. 
 
We also recommend that at least once a year, or after 25 discharge tests, which ever comes 
first, that each test analyzer be sent back to our service facility for preventive maintenance 
and factory calibration. 
 
Units are factory calibrated with certified gas mixtures. 
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VIII. RECOMMENDED SPARES 
 

 Quantity Part Number Description 
 
 3  Filter, Sample Line 
 2  Fuse, 1.25A 
 3  Sample Line (50ft. [50.24m] long, ¼” O.D. x 1/8” 

I.D.) 
 1  Power Cord 

 
Refer to current price list for pricing. 
 
IX. OPERATING HINTS 
 

1. Warm-up Time and Sample Line Location 
 
Allow the unit to warm-up for 10 minutes before adjusting the baseline with the sample 
line placed in the location where the sampling is to be performed.  The baseline on the 
recorder may shift by 2% of full scale periodically.  Take this into account when adjusting 
the scale. 
 

2. Field Calibration: Environmental Conditions and Interpretation of Results 
 
When performing the field calibration, try to calibrate the unit under the same 
environmental conditions as those anticipated for actual use.  Temperature and humidity 
will not significantly affect the calibration, but will cause a shift in the baseline.  A 
difference to 3% of the full scale from the field calibration reference figures is not 
indicative of the need to recalibrate.  The field calibration serves to alert the user to gross 
calibration errors due to malfunction or mis-adjustment of the unit.  Typically, the analyzer 
needs to be recalibrated only infrequently.  Analyzer malfunctions will always result in 
large deviations in the recorder readings or in total lack of operation. 
 

3. Need for Repetition During Calibration 
 
When calibrating the analyzer or performing a field calibration, repeat the procedure at 
least two times.  The initial zero may deviate by 2% of full scale due to “out-gasing” of 
absorbed sample gas from the 50 ft. [15.25m] PVC sample lines. 
 

4. Calibration Gases 
 
Certified gas mixtures the sample gas in air may be used with the gas mixture set-up. 
 
100% concentrations of liquefied sample gas can also be used when calibrating the unit.  
These gasses must be supplied to the analyzer in diluted and gaseous form.  Therefore, 
cylinders of liquefied sample gas must not have siphon or diptubes. 
 

5. Transportation and shipping: 
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The unit is not designed to be shipped commercially.  Pack unit into a larger container 
with excess padding to prevent damage. 



X. TRILOGGER SOFTWARE 
 
1. Installation 

 
a. Run SETUP.EXE on CD provided. 
b. Follow on screen instructions. 

 
2. Downloading 
 

a. Run TRILOGGER.EXE. 
b. Connect analyzer to com1 on your computer with 9 pin serial cable (Not included). 
c. From Upload menu click Upload. 
d. Click Upload button. 
e. Set the Acquire/Download switch to DOWNLOAD. 
f. Turn analyzer on. 
g. Follow on screen instructions to complete the download. 
h. After uploading is complete, the analyzer can be turned off. 

 
3. Processing 
 

a. From Upload menu select Process Data. 
b. Click Process Data button. 
c. Click Process to CDFF button. 
d. When complete click Done button. 

 
4. Creating Charts. 

 
a. Open file Trilog2 (located in the same directory as Trilogger.exe). 
b. Highlight all data. 
c. Copy data 
d. Close Trilogger program. 
e. Paste data in Microsoft Excel. 
f. Highlight data (may already be highlighted from paste). 
g. From Data menu select Text To Columns. 
h. Check the Delimited box. 
i. Click Next button. 
j. Check the Comma and Space boxes under delimiters. 
k. Click Next button. 
l. Review proposed changes, if satisfactory click Finish button. 
m. Highlight cells in columns B, C and D containing data. 
n. From Data menu select SORT. 
o. Sort data by column B. 
p. Check No Header Row. 
q. Click OK button. 
r. Highlight column C cells for Channel 1 data (cells containing “1” in column B). 
s. From Insert menu select CHART. 
t. Select Line type chart. 
u. Click Next button. 
v. From Chart Source Data window click on the Series tab. 
w. Click button in white box labeled Category (X) Axis Labels. 
x. Highlight column D cells for channel 1 data. 
y. Click button in white box. 
z. Click Next button. 
aa. Enter chart, X and Y titles. 
bb. Click Next button. 

Revision 2  10/02 12 

cc. Click Finish button. 
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dd. Repeat steps 18 to 29 for channels 2 & 3. 
ee. Save file for future reference. 
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